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How to Read This Manual

Symbols

The following set of symbols is used in this manual.

Indicates a situation that may result in property damage or malfunction if instructions are not followed. Be
sure to read the instructions.

Indicates information or preparations required prior to operating.

Indicates a function's limitations.

Indicates supplementary relevant information.

Indicates where you can find further relevant information.

[ ]
Indicates the names of keys that appear on the computer screen.

Terminology

The following is an explanation of the terminology used in this manual:

Term Explanation

Device A "device" is a printer or multifunction machine connected to the network or
a printer connected to a computer via USB. Though the term generally includes
routers, hubs, and other network devices, "device" in this manual is limited to
printers and multifunction machines.

Domain name Name of the domain with which computers with Remote Communication Gate
S installed are affiliated. Entry is required if the Domain name entry field
appears on the login screen. Ask the administrator for detailed information.
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Term Explanation

Download In general, download is a process of receiving and saving a copy of programs
or files in a computer via a network. In Remote Communication Gate S, it refers
to the process of a user computer receiving and saving packages stored on
the Remote Communication Gate S server.

Filter On the device list screens, you can use filters to display only the printers or
logs that meet specified conditions. Thus, you can sort the devices to be
displayed by using the filtering functions. The filters created by the
administrator and users and the filters created by a user can be edited by that
user.

Group The administrator creates groups in order to classify devices. Groups are
displayed on the [Directory] tab and clicking them displays the device used
in the group.

Login Connection to Remote Communication Gate S on the network, noticing a state
in which operations are enabled.

Logout Disconnection from Remote Communication Gate S.

Menu bar Grouping of operations that can be executed on displayed screens. Items are
selected on the drop-down menu.

Package (Installation
Package)

A package is an ".exe" file that contains all of the necessary files and settings
to install a device driver. Packages are used to distribute device drivers by the
administrator via Remote Communication Gate S. You can download it from
the Remote Communication Gate S and all content registered in a package
is installed by running the ".exe" file.

Screens

The explanations in this manual use screen images from Windows Vista and Internet Explorer 7.0. If you
use another version of Windows, screen images may differ. However, you can perform the same steps.
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Guides for This Solution
The following guides are available for Remote Communication Gate S:

Remote Communication Gate S User's Guide (this manual, HTML/PDF)

This guide is intended for the end user. It explains how to display devices, search for devices, and
install packages by logging in Remote Communication Gate S.

Remote Communication Gate S Installation Guide (HTML/PDF)

This guide is intended for the administrator and explains the installation, uninstallation, and initial setup
procedures for Remote Communication Gate S.

Remote Communication Gate S Administrator Operations Guide (HTML/PDF)

This guide is intended for the administrator. It explains how to utilize Remote Communication Gate
S to configure and manage settings and operations: for example, registration and monitoring of
devices, the creation of installation packages, or retrieval of device logs.

• Acrobat Reader or Adobe Reader is required to view the PDF documentation.

• You can view the HTML documentation using a Web browser. We recommend Microsoft Internet
Explorer 4.01 SP2 or a later version.

• A simplified version of the HTML documentation is available for earlier or non-recommended
browsers.

• If JavaScript is disabled or unavailable in your browser, you will not be able to search or use certain
buttons in the HTML documentation.

• If you are using an earlier or non-recommended browser and the simplified version of the
documentation does not appear automatically, replace \int\index_book.htm with \unv
\index_book.htm in your browser's address bar.
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Important
• TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW:

• THE SUPPLIER SHALL NOT BE LIABLE FOR THE RESULT OF OPERATION OF THIS SOFTWARE
OR THE USE OF THIS DOCUMENT.

• THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR DAMAGES OR LOSS OF ANY
DOCUMENT OR DATA PRODUCED BY USING THIS SOFTWARE.

• THE SUPPLIER SHALL NOT BE LIABLE TO YOU FOR ANY CONSEQUENTIAL, INCIDENTAL
OR INDIRECT DAMAGES (INCLUDING, BUT NOT LIMITED TO, DAMAGES FOR LOSS OF
PROFITS, BUSINESS INTERRUPTION OR LOSS OF BUSINESS INFORMATION, AND THE
LIKE) CAUSED BY FAILURE OF THIS SOFTWARE OR LOSS OF DOCUMENTS OR DATA, NOR
FOR ANY OTHER DAMAGES ARISING OUT OF THE USE OF THIS SOFTWARE, IF THE
SUPPLIER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

• Some illustrations or explanations in this guide may differ from your product due to improvement or
change in the product.

• The contents of this document are subject to change without notice.

• No part of this document may be duplicated, replicated, reproduced in any form, modified or quoted
without prior consent of the supplier.

• It is possible that any document or data stored in the computer will be damaged or lost by user error
during operation or software error. Be sure to back up all important data beforehand. Important
documents and data should always be copied or backed up. Documents and data can be lost because
of malfunction or human error. Furthermore, the customer is responsible for protection measures
against computer viruses, worms, and other harmful software.

• Do not remove or insert any disk while operating this software.
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Trademarks
Adobe®, Adobe Acrobat®, Acrobat Reader® and Flash® are either registered trademarks or trademarks
of Adobe Systems Incorporated in the United States and/or other countries.

Microsoft®, Windows®, Windows Server®, Windows Vista®, and Internet Explorer® are either registered
trademarks or trademarks of Microsoft Corporation in the United States and/or other countries.

Pentium® is a registered trademark of Intel Corporation.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights to those marks.

This product includes software developed by the OpenSSL Project for use in the OpenSSL Toolkit.
(http://www.openssl.org/)

The proper names of the Windows operating systems are as follows:

• The product names of Windows 2000 are as follows:

Microsoft® Windows® 2000 Professional

Microsoft® Windows® 2000 Server

Microsoft® Windows® 2000 Advanced Server

• The product names of Windows XP are as follows:

Microsoft® Windows® XP Home Edition

Microsoft® Windows® XP Professional

• The product names of Windows Vista are as follows:

Microsoft® Windows Vista® Ultimate

Microsoft® Windows Vista® Enterprise

Microsoft® Windows Vista® Business

Microsoft® Windows Vista® Home Premium

Microsoft® Windows Vista® Home Basic

• The product names of Windows 7 are as follows:

Microsoft® Windows® 7 Home Premium

Microsoft® Windows® 7 Professional

Microsoft® Windows® 7 Ultimate

• The product names of Windows Server 2003 are as follows:

Microsoft® Windows Server® 2003 Standard Edition

Microsoft® Windows Server® 2003 Enterprise Edition

• The product names of Windows Server 2003 R2 are as follows:

Microsoft® Windows Server® 2003 R2 Standard Edition
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Microsoft® Windows Server® 2003 R2 Enterprise Edition

• The product names of Windows Server 2008 are as follows:

Microsoft® Windows Server® 2008 Standard

Microsoft® Windows Server® 2008 Enterprise

• The product names of Windows Server 2008 R2 are as follows:

Microsoft® Windows Server® 2008 R2 Standard

Microsoft® Windows Server® 2008 R2 Enterprise
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1. Pre-operation Confirmation
This chapter explains Remote Communication Gate S and system requirements for user's computers to
operate Remote Communication Gate S.

What You Can Do with Remote Communication
Gate S
Remote Communication Gate S is a Web-based application that provides device management solutions.

Logging in from a computer to the Remote Communication Gate S server using a Web browser allows you
to perform the following:

• Display the device list using search conditions

• Display the device map with device status and its location

• Display the detailed information for devices

• Download and Install drivers using a package created by the administrator

• For details about displaying the device list and searching for devices, see p.25 "Displaying the
Device List".

• For details about displaying the Map, see p.35 "Displaying Maps".

• For details about displaying detailed device information, see p.41 "Displaying Device
Information".

• For details about downloading and installing drivers using packages, see p.50 "Downloading
Packages" and p.54 "Opening Packages and Installing Drivers".
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System Requirements
To operate Remote Communication Gate S, the system must meet the following requirements.

Item Requirements

Hardware • CPU: Pentium compatible 500 MHz or higher

• Memory: 128 MB or higher

• Minimum available hard disk space: same as recommended
minimum for operating system

Operating System • Windows 2000 Professional/Server/Advanced Server (i386):
Service Pack 4 or later

• Windows XP Home Edition/Professional: Service Pack 2 or later

• Windows Vista Ultimate/Enterprise/Business/Home Premium/
Home Basic

• Windows 7 Home Premium/Professional/Ultimate

• Windows Server 2003 Standard Edition/Enterprise Edition:
Service Pack 2 or later

• Windows Server 2003 R2 Standard Edition/Enterprise Edition:
Service Pack 2 or later

• Windows Server 2008 Standard/Enterprise

• Windows Server 2008 R2 Standard/Enterprise

Supported Language English, German, French, Italian, Spanish, Dutch

• Remote Communication Gate S supports only these six
languages. If the display language is not one of these languages,
Remote Communication Gate S is displayed in English. The
priority of the display language can be changed in the Language
preference settings in Internet Explorer.

1. Pre-operation Confirmation
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Item Requirements

Web Browser • Internet Explorer 6.0 Service Pack 1 or later

• Internet Explorer 7.0

• Internet Explorer 8.0

• JavaScript must be activated.

• Adobe Flash Player 9.0 or later must be installed.

• For details about the method for activating JavaScript, see
p.11 "Activating Browser JavaScript".

Network TCP/IP must be installed and properly configured.

Screen Resolution 1024 x 768 or higher

Activating Browser JavaScript

To access and view Remote Communication Gate S, it is necessary to activate JavaScript on the Web
browser.

1. Select [Internet Options...] on the Internet Explorer [Tools] menu.

2. Click the [Security] tab.

3. Click [Custom Level...].

4. Under [Scripting] select [Enable] in [Active scripting].

5. Click [OK] to close the [Security Settings] dialog box.

6. Click [OK] to close the [Internet Options] dialog box.

System Requirements
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2. Login and Logout
This chapter explains the procedures for logging in and out of the Remote Communication Gate S server.

Login
To log in to the Remote Communication Gate S server, the following information is required and must be
obtained from the administrator in advance:

• URL of the Remote Communication Gate S server

• User name

• Password

• Domain name (If required)

• If you are using Windows Server 2003 or 2008, settings must be made in advance. Contact
the administrator.

• When using Remote Communication Gate S, do not use your browser's [Back] button or other
browser functions. Use only the navigation controls on the content pages.

• If you want to switch users, click the [Logout] button, and then log in again as a different user.
Do not use your browser's [Back] button to redisplay the login screen.

1. Start Internet Explorer.

2. Enter the following URL in the address bar, and then press the [Enter] key on the keyboard.

Condition URL

Without SSL encryption http://{host name}:{port number}/mgmt

or

http://{IP address}:{port number}/mgmt

With SSL encryption https://{host name}:{port number}/mgmt

or

https://{IP address}:{port number}/mgmt

• {host name}: name of the Remote Communication Gate S server

• {IP address}: IP address of the Remote Communication Gate S server

• {port number}: port number specified when Remote Communication Gate S was installed

13
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3. If the [Trial Version] screen appears, click [OK].

• The [Trial Version] screen will only appear if Remote Communication Gate S has not been
activated. For details, contact the administrator.

4. Enter your user name in the [User name:] box on the login screen.

5. Enter your password in the [Password:] box.

• For details about changing your password, see p.24 "Changing the Login Password".

6. Enter domain name if the [Domain name:] box is displayed.

7. Click [Login].

• The login screen reappears if no operation is performed for more than 30 minutes after logging
in to the Remote Communication Gate S server. Log in again if necessary.

2. Login and Logout
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Logout
Use the following procedure for logging out from Remote Communication Gate S.

1. Click [Logout] on the screen.

• Do not use the [Close] button to shut down the system.

Logout
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3. Displaying Device Information
This chapter explains the device list screen which is displayed on the top page when you log in Remote
Communication Gate S.

Layout of the Device List Screen
The screen layout of the device list is as follows:
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BXM001S

1. Search button

Searches for a specific device using search conditions. When searching for a device, click this button,
and then enter the conditions for your search.

• For details about searching for devices using Search button, see p.25 "Displaying the Device
List by Specifying Search Conditions".

2. Group display

Displays the group name of the displayed device list.

3. [Directory] tab

Displays registered filters and groups.

4. Filter

Refines the device list using search conditions. When a filter is selected, the corresponding devices
are displayed in the device list display area.

Filters can be added by the administrator, and you can also create your own filters. Filters that you
create are available only to you.
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• For details about searching for devices using filters, see p.28 "Displaying the Device List by
Using Filters".

5. Group list

Displays the group list if the device is managed as a group.

6. Menu bar

Displays the menu that is available on the device list screen.

7. [Quick Links] area

Displays screen links that are used frequently or related to the present screen. For details about the
selected links, contact the administrator.

8. Site Map button

Displays all operation links that are available in Remote Communication Gate S.

• For details about Site Map, see p.23 "Layout of Site Map".

9. Help button

Displays the Help screen.

• For details about Help, see p.55 "About Help".

10. [Logout] button

Logs out from the Remote Communication Gate S server.

• For details about logout, see p.15 "Logout".

11. Login user name

Displays the login user name.

12. Refresh button

Refreshes the device list screen and displays the latest device information.

13. Device list display area

Displays the list of devices.

Device List Menu Functions

Various functions available in the [Directory] tab are also accessible from the menu bar. The device list
menu provides the following functions:

3. Displaying Device Information
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[Edit] menu

Item Allows you to

Select All Select all found devices in the list.

Clear All Deselect all devices selected in the list.

[Printer] menu

Item Allows you to

Refresh Selected Device Connect to the selected devices and collect details about their current
device status. The device list screen is not updated when you select this
item.

To display the device list screen with the most recent device status
information, select [Refresh Selected Device] on the menu, and then click
the Refresh button in the right-upper area on the screen.

Printer Properties... Display details of a selected device.

• For details about the [Printer Properties...] menu, see p.41
"Displaying Device Information".

[Filter] menu

Item Allows you to

Printers with Errors Display a list of devices with errors on the [Printers with Errors] screen.

• For details about searching devices with errors, see p.28
"Displaying a list of devices with errors".

No Response Devices Display a list of devices that have not responded to polling for a specified
number of days.

No Filters Display a list of all found devices.

Filter Settings... Register and edit filters that you created.

[View] menu

Item Allows you to

Display Directory Display the [Directory] tab.

Layout of the Device List Screen
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Item Allows you to

Hide Directory Hide the [Directory] tab.

List Display a list of devices.

Map Display a floor map of grouped devices with device icons.

• For details about the Map function, see p.35 "Displaying
Maps".

Search Devices... Display the [Search] screen.

• For details about searching for devices, see p.25 "Displaying
the Device List by Specifying Search Conditions".

[Sort by] menu

Item Allows you to

Selected Printers Sort the list of found devices alphabetically according to selected
printers.

Device Display Name Sort the list of found devices alphabetically according to model names.

IP Address Sort the list of found devices according to their IP addresses.

System Sort the list of found devices according to common system icons.

Printer Sort the list of found devices according to printer status icons.

MAC Address Sort the list of found devices according to their MAC addresses.

Registered Group Sort the list of found devices according to the groups that the devices
are registered to.

Features of Status Icon on the Device List

Status icons appear on the device list screen and inform the visual notice with icons.

3. Displaying Device Information
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1. System status icon

• There are several types of system status icon. For the details about each icon, see p.21 "System
status icons".

2. Printer status icon

• There are several types of printer status icon. For details about the each icon, see p.22 "Printer
status icons".

The following table explains the various icons displayed in the device list:

System status icons

Status icon Explanation

There was no response from the printer.

A service call is required.

The printer has run out of paper, toner, or other supplies.

An access violation has occurred.

An excessive number of attempts have been made to access this device.

Layout of the Device List Screen
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Printer status icons

Status icon Explanation

There was no response from the printer.

The printer has run out of toner/ink.

A paper jam has occurred.

The printer has run out of paper.

A cover is open.

The printer has run out of staples.

The punch waste receptacle is full.

The waste toner receptacle is full.

A paper jam has occurred inside the Auto Document Feeder (ADF).

A communication error has occurred.

The paper output tray is full.

An output tray is full.

An unavailable function was attempted.

An unknown error has occurred.

The printer is currently offline.

The printer is warming up.

The printer's toner/ink is about to run out.

The printer's paper is about to run out.

Warning concerning a failed operation or unsupported function.

3. Displaying Device Information
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Status icon Explanation

The printer is in Power Save Mode.

The printer is busy processing and not ready to perform a new operation.

The printer is busy printing a job.

The printer is ready to perform a new print job.

Layout of Site Map

The screen layout of the Site Map is as follows:
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1. All Printers

Displays a list of devices connected to Remote Communication Gate S.

• For details about device list, see p.17 "Layout of the Device List Screen".

2. Printers with Errors

Displays a list of devices with system errors.

• For details about Printer with Errors, see p.28 "Displaying a list of devices with errors".

3. [Back] button

Returns to the previous page.

4. User Account Settings

Displays [User Information] screen, and you can change the password for login.

• For details about User Account Settings, see p.24 "Changing the Login Password".

Layout of the Device List Screen
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5. Filter Settings

Displays the [Filter Settings] screen, and you can edit or delete registered filters.

• For details about Filter Settings, see p.31 "Editing filters", and p.33 "Deleting filters".

Changing the Login Password

The following procedure allows you to change your login password. Change your password for security
reason.

1. On the device list screen, click the Site Map button in the upper-right area.

2. Click [User Account Settings].

3. Enter the new password.

4. Click [OK].

3. Displaying Device Information
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Displaying the Device List
Displaying the device list allows you to check the status and details of the devices connected to the Remote
Communication Gate S server.

Network-connected devices are displayed in lists, which are sorted according by one of the two methods
below:

• Specified search conditions

• Use of filters

Displaying the Device List by Specifying Search Conditions

Use the following procedure to display a list of devices according to advanced search conditions.

1. On the device list screen, click the Search button.

Displaying the Device List
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2. Select items as search conditions from the [Search item:] list.

Search condition Explanation

Device Display Name Displays devices according to their names on the MFP
screen.

Printer model Displays devices according to their printer models.

IP address Displays devices according to their IP addresses.

System error Displays devices according to common system errors such
as no response and failure due to excessive access
attempts.

Printer status Displays devices according to their print status.

MAC address Displays devices according to the physical (MAC)
address that all network-capable devices feature.

Device name Displays devices according to their device names.

Host name Displays devices according to their host names.

Comment Displays devices according to a comment filter.

PPM Displays devices according to their print capacity
(measured in pages per minute).

B&W/Color Displays devices according to their Black and White/
Color printing capability.

Scanner status Displays devices according to their scanner status.

Fax status Displays devices according to their fax status.

Copier status Displays devices according to their copier status.

3. Displaying Device Information
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Search condition Explanation

NIB model Displays fail-over devices according to their NIB models.

NIB version Displays fail-over systems according to their NIB versions.

NetWare print server Displays devices according to their NetWare print server.

Serial Number Displays devices according to their serial numbers.

Asset number Displays devices in numerical order according to their
number of asset utilities.

User Properties 1

User Properties 2

User Properties 3

User Properties 4

User Properties 5

Displays devices according to their user properties
(specified by the administrator).

3. Select an option configuration item from the [Option:] list.

Condition Option

When specifying a character string for the parameter: • include

• Exact match

When specifying a numeric value for the parameter: • same

• above

• below

When specifying a numeric value (a range can be specified) for
the parameter:

• range

• same

• above

• below

When selecting the parameter from choices: • same

Displaying the Device List
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4. Enter the set value in the [Parameter:] box. For example, if [IP address] is specified in [Search
item:], enter the IP address.

• If you click [Clear Conditions], the search conditions return to their defaults.

5. Click [Search...].

The [Search Results] screen appears as a list.

Displaying the Device List by Using Filters

Use the following procedure to display the device list as corresponding to the filter conditions that are
specified by the administrator and users.

The filters that created by the administrator are displayed in the upper area of [Filter] menu. You cannot
edit filters that were created by the administrator.

Filters that you create for personal use from search conditions appear under the filters created by the
administrator. You can edit and delete the filters that you create.

Displaying a list of devices with errors

Use the following procedure to display a list of devices with errors.

3. Displaying Device Information
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1. On the device list screen, click [View by Filter] on the [Directory] tab.

2. Click [Printers with Errors].

• The filter can also be selected from [Filter] on the menu.

Displaying a list of devices not responding

Use the following procedure to display a list of devices that have not responded to polling for a specified
number of days.

1. On the device list screen, click [View by Filter] on the [Directory] tab.

Displaying the Device List
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2. Click [No Response Devices].

The result appears as a list that you can sort by item.

Displaying a list of devices using other filters

Use the following procedure to display a list of devices according to search conditions that specified by
the administrator and users.

1. On the device list screen, click [View by Filter] on the [Directory] tab.

2. Click the filter you want to use.

The search result appears as a list.

• The filter can also be selected from [Filter] on the menu.

Registering search conditions as a filter

Use the following procedure to register search conditions as a filter for your personal use.

1. On the device list screen, click the search button.

2. Select items as search conditions from the [Search item:] list.

3. Select an option configuration item from the [Option:] list.

4. Enter a value in the [Parameter:] box. For example, you selected [IP address] in [Search
item:], enter the IP address you want to search for.

5. Click [Search...], and then click [Save as Filter].

3. Displaying Device Information
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6. On the [Filter Settings: Save as Filter] screen, enter [Filter name:] and [Comment:].

7. In [Display location:], select where to have the filter displayed.

8. Click [OK].

9. On the [Saved as Filter] screen, click [OK].

• You can register up to 20 filters.

• The registered filters are displayed on the [Filter] menu, under the filters created by the administrator.

Filter Settings menu functions

The menu on the [Filter Settings] screen provides the following functions:

[Edit] menu

Item Allows you to

Edit Edit the filter conditions.

Delete Delete the registered filters.

Editing filters

Use the following procedure to edit a filter that you created.

Displaying the Device List
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1. On the device list screen, click the Site Map button in the upper-right area.

2. Click [Filter Settings].

3. Select the filter you want to edit.

4. Click [Edit] on the [Filter] menu.

5. Change the [Filter name:] and [Comment:] as necessary.

6. In [Display location:], select where to have the filter displayed.

7. Click [OK].

8. On the [Filter Settings] screen, click [Back].

9. On the Site Map, click [Back].

The device list screen appears.

• You can also access the filter editing function by clicking [Filter Settings] on the Site Map.

3. Displaying Device Information
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Deleting filters

Use the following procedure to delete filters that you created.

1. On the device list screen, click the Site Map button in the upper-right area.

2. Click [Filter Settings].

3. Click [Delete] on the [Filter] menu.

4. When a message confirming the deletion appears, click [OK].

Sorting the Display Order of the Device List

Use the following procedure to sort the display order of the device list.

Displaying the Device List
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1. Click [Sort by] on the menu on the device list screen.

2. Click the item to be designated as the sort key.

Devices will be sorted on the basis of the selected item.

• To sort the list in ascending order, click the row name of the item in the displayed list. Clicking
again sorts the list in descending order.

3. Displaying Device Information
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Displaying Maps
The Map function displays a floor map of grouped devices using device icons that provide visual details
about a device and its location. Each group has one map registered by the administrator. If no map is
registered for a group, the Map for that group appears blank.

The Map function allows you to perform the following:

• Display devices' visual location and their status

• Display the device information

• Download packages

There are two ways to display the Map as below.

• Display the Map from the device list

• Display the simplified Map from the printer properties

Displaying the Map from the Device List

Use the following procedure to display grouped devices in the Map.

1. On the device list screen, click [View by Group] on the [Directory] tab.

2. Click a group in the group tree.

A list of grouped devices appears.

Displaying Maps
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3. Click the [Map] on the [View] menu.

4. Click a device icon on the Map to display the properties screen.

Layout of the Map

The screen layout of the Map is as follows:

3. Displaying Device Information
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1. View List button

Displays in list form the devices that appear on the Map.

2. [Directory] tab

Displays registered filters and groups.

3. Menu bar: [View]

Displays the menu that is available on the Map.

4. Map display area

Displays the Map with device icons.

5. Refresh button

Refreshes the Map screen and displays the latest device status.

6. [Map Opacity:] slider

Adjusts the transparency of the background of the Map.

7. [Map size:] buttons

Increases or decreases the size of the Map.

8. Device icon (Red)

Indicates printers with common system errors.

9. Device icon (Gray)

Indicates local (non-networked) printers.

10. Device icon (Blue)

Indicates networked printers that are registered to the Remote Communication Gate S. If you move
your mouse pointer over a device's icon, the model ID and IP address/host name of that device will
appear.

Displaying Maps
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Map menu functions

The menu on the [Printers: Map] screen provides you the following function:

[View] menu

Item Allows you to

Display Directory Display the [Directory] tab.

Hide Directory Hide the [Directory] tab.

List Display a list of devices that appear on the Map.

Map Display a floor map of grouped devices with device icons.

Resizing the Map display

Use the following procedure to resize the Map.

1. On the Map, click the [Map size:] buttons.

• Magnification range: ±200%

Adjusting the transparency of the background

Use the following procedure to adjust the transparency of the background of the Map.

1. On the Map, slide the [Map Opacity:] slider.

Displaying the Simplified Map from the Printer Properties

Use the following procedure to display the Map from the [Printer Properties: User Properties] screen.

The displayed Map is a simplified figure and shown items are different from that of displayed from the
device list. The icon of the device that you selected will be blinking.

1. On the device list screen, select a check box of the device list.

2. Click [Printer Properties...] on the [Printer] menu.

3. Click the [User Properties] tab.
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4. Click the [View Map] button on the [Printer Properties: User Properties] screen.

Layout of the simplified Map

The screen layout of the simplified Map is as follows:
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1. [Web Image Monitor] button

Displays the device status using Web Image Monitor.

2. Device name/Group name

Displays the device name and group that the device belongs to.

3. Map display area

Displays the simplified Map with device icons.

Displaying Maps
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4. Help button

Displays the Help screen about the Map.

5. Refresh button

Refreshes the Map screen and displays the latest device status.

6. [Map Opacity:] slider

Adjusts the transparency of the background of the Map.

7. [Map size]:buttons

Increases or decreases the size of the Map.

8. Device icon (Blinking)

Indicates the selected device.

9. Device icon (Red)

Indicates printers in common system errors.

10. Device icon (Gray)

Indicates local (non-networked) printers.

11. Device icon (Blue)

Indicates networked printers that are registered to the Remote Communication Gate S server. If you
move your mouse pointer over a device's icon, the model ID and IP address/host name of that device
will appear.
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Displaying Device Information

Displaying Device Information from Menu Bar

Use the following procedure to display the properties screen, which features device information.

1. On the device list screen, select a check box of the device list.

2. Click [Printer Properties...] on the [Printer] menu.

Displaying Device Information from the Properties Icon

Use the following procedure as an alternate way to display device information.

Displaying Device Information
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1. On the device list screen, click the properties icon.

Content of the Device Information Screen

The properties screen displays detailed information about a selected device features the following tabs:

• Printer Status

• Counter

• User Properties

• Download

The following items appear at the top of the properties screen.

Item Explanation

Device Display Name Displays the name of a device as displayed in Remote
Communication Gate S. Device details are displayed by
clicking the [Web Image Monitor] link.

Printer model: Displays the model name of the device.

Device Address Displays the IP address or host name of the device.

3. Displaying Device Information
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Item Explanation

Latest Device Information Update Time: Displays the time and date when detailed device information
was most recently updated.

Printer Status tab

This screen displays the status of the selected device.

1. Click the [Printer Status] tab.

• Displays may differ depending on device models.

Item Explanation

System

Printer

Copier

Scanner

Displays the selected device's status with status icons.

• For details about status icons, see p.20 "Features of
Status Icon on the Device List".

<Paper tray> Displays the status of the input tray.

<Toner/Ink> Displays the remaining toner.

Displaying Device Information
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Item Explanation

<Output tray> Displays the output tray attached to the device.

<Document server> Displays the capacity and free space of the document
server.

Counter tab

This screen displays device counter data collected from devices connected to Remote Communication Gate
S. The device counter data can help you know how the device is being used.

1. Click the [Counter] tab.

• Displays may differ depending on device models. The counter data will be retrieved from devices
that maintain usage counters.

Item Explanation

<Print total> Displays copy, printer and fax counter totals.

• Total counter

3. Displaying Device Information
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Item Explanation

<Copier> Displays copy function counter.

• Copier B&W Counter

• Copier Full Color Counter

• Copier Single Color Counter

• Copier Two-color Counter

<Printer> Displays printer function counter.

• Printer B&W Counter

• Printer Full Color Counter

• Printer Single Color Counter

• Printer Two-color Counter

• Total Level Color Counter

<Fax> Displays fax function counter.

• Fax B&W Counter

• Fax Single Color Counter

<A3/DLT> Displays large size print function counter.

• A3/DLT

<A2> Displays A2 size print function counter.

• A2

<Duplex> Displays two-sided print function counter.

• 2 Sided

<Coverage> Display toner coverage function counter.

• Coverage: Color (%)

• Coverage: B&W (%)

• Coverage: Color Print Page

• Coverage: B&W Print Page

<Send/TX total> Displays send/TX total counter and fax transmission
counter totals.

• Send/TX Total B&W Counter

• Send/TX Total Color Counter

Displaying Device Information
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Item Explanation

<Fax transmission> Displays fax transmission function total.

• Fax Transmission Counter

<Scanner send> Displays scanner send function counter.

• Scanner Send B&W Counter

• Scanner Send Color Counter

<Internal Counter> Displays the internal counter totals.

• Color Copies

• B&W Copies

• Color Prints

• B&W Prints

• Economy Color Counter

• B&W Total

• Color Total

User Properties tab

This displays groups with which devices are associated.

1. Click the [User Properties] tab.

3. Displaying Device Information
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Item Explanation

<Registered group> Displays the groups with which devices are associated.

<User properties> Displays comments regarding on user properties.

View Map button If a map has been created for the group, this button
displays the map in simplified view.

• For details about the using View Map button, see p.38 "Displaying the Simplified Map from the
Printer Properties".

Download tab

This displays a list of packages created by the administrator for the devices.

1. Click the [Download] tab.

• For details about the packages, see p.50 "Downloading Packages".
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4. Downloading and Installing
Packages
This chapter explains downloading and installing packages distributed by the administrator.

What Are Packages?
Remote Communication Gate S discovers devices on networks and distributes to all users a configuration
setting program wizard called "Packages". The packages wizard starts automatically and users can install
the necessary drivers for devices from Remote Communication Gate S server without any additional setup.

The following explains how to acquire a package and then install drivers using the package.
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Downloading Packages
The packages are stored in the Remote Communication Gate S server.

The packages are retrieved using any of the following three procedures:

• Log in to the Remote Communication Gate S server and download from the package list.

• Log in to the Remote Communication Gate S server and download from the Map.

• Access the URL sent by the administrator in an e-mail message and download from the package list.

Downloading Packages from the Package List

Use the following procedure to download packages from the package list.

1. On the device list screen, select a check box of devices.

2. Click [Printer Properties...] on the [Printer] menu.

• For details about displaying the device information screen, see p.41 "Displaying Device
Information".

4. Downloading and Installing Packages
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3. Click the [Download] tab on the properties screen.

4. For detailed information about the package, click the properties icon.

5. Click [Download] next to the package you want to download.

6. Click [Save].

7. Specify where you want to save the package, and then click [Save].

The download begins.

8. Click [Close] to close [Download Completed] dialog box.

• For details about opening the package, see p.54 "Opening Packages and Installing Drivers".

Downloading Packages
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Downloading Packages from the Map

Use the following procedure to download packages from the Map.

1. Display the Map.

• For details about how to display the Map, see p.35 "Displaying Maps".

2. Click a device icon of device whose package you want to download.

3. On the properties screen, click the [Download] tab.

4. For detailed information about the package, click the properties icon.

5. Click [Download] next to the package you want to download.

6. Click [Save].

7. Specify where you want to save the package, and then click [Save].

The download begins.

8. Click [Close] to close [Download Completed] dialog box.

Downloading Packages with a URL Sent by E-mail

Use the following procedure to download packages with a URL sent by e-mail.

1. Click the URL written in the text of the e-mail sent by the administrator.

A download confirmation screen appears.

• For details about entering a URL manually, see p.53 "If Internet Explorer does not start
automatically".

2. Click [Login].

4. Downloading and Installing Packages
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3. Click [Save].

4. Specify where you want to save the package, and then click [Save].

The download begins.

5. Click [Close] to close [Download Completed] dialog box.

If Internet Explorer does not start automatically

Use the following procedure to start Internet Explorer when the URL notified by e-mail does not start
automatically.

1. Start Internet Explorer manually.

2. Copy and paste the URL from the e-mail into the Internet Explorer address bar.

3. Press the [Enter] key.

Internet Explorer starts and the login screen appears.

Downloading Packages
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Opening Packages and Installing Drivers
Use the following procedure to open packages and install them to your computers.

• Before opening a package, log on to Windows as an Administrators group member and close any
applications that are running.

1. Open the folder where the package is saved.

2. Double-click the downloaded package (.exe file).

3. When the [Security Warning] screen appears, click [Yes].

4. On the [User Account Control] screen, click [Allow].

5. Read the terms of the license agreement. If you agree with them, click [I accept the
agreement], and then click [Next].

Installation of the drivers starts.

6. If [Confirm restart.] appears, click [Yes. Restart right now.], and then click [Finish].

Windows restarts.

• During installation, the [Software Installation] dialog box may appear. In this case, click [Continue
Anyway] to continue the installation.

4. Downloading and Installing Packages
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5. Appendix

About Help
To understand operating procedures, see Help.

There is a Help button located on the login screen, the device list screen, and other screens. Clicking the
Help button displays Help.

Login screen

BXM006S

Device list screen

BXM007S
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Other screen

BXM008S

If Your Computer is Running Windows XP Service Pack 2 or later/Vista/7

• Under Windows XP Service Pack 2 or later/Vista/7, Help may not be displayed correctly because
active content may be restricted from being shown depending on the Internet Explorer settings. Use
the following procedure to deactivate active content controls.

1. Click [To help protect your security, Internet Explorer has restricted this file from showing
active content that could access your computer. Click here for options...].

A menu is displayed.

2. On the menu bar, select [Allow blocked content...].

3. Click [Yes] on the [Security Warning] dialog box.
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Troubleshooting
This describes the solutions for problems that maybe arise during operating Remote Communication Gate
S. See the table below and perform the suggested solution in order to address the problem.

Problem Cause and solutions

In the login screen, you cannot
login to the Remote
Communication Gate S.

The password might not be correct. Ask the administrator to confirm the
password.

The Remote Communication
Gate S login screen does not
appear.

The Remote Communication Gate S server's URL specified in the
browser is incorrect. Ask the administrator how to access to the Remote
Communication Gate S Server.

The login screen reappears
after a certain amount of time
has passed.

The Login screen reappears if no operation is performed for more than
30 minutes after logging in to the Remote Communication Gate S
server. Log in again if necessary.

The device list or other lists do
not appear when connecting
via SSL.

You might have enabled the saving of encrypted pages. To turn off this
function:

1. On the Internet Explorer menu bar, click [Tools] > [Internet
Options...], and then select the [Advanced] tab.

2. Clear the [Do not save encrypted pages to disk] check box.

3. Click [OK].

Troubleshooting
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